Robot hexapode

Apprendre a programmer et a monter un robot

@D Difficulté Difficile ® Durée 25heure(s) W Catégories Electronique, Machines & Outils, Robotique

Colt 125EUR (€)

Sommaire

Introduction

Video d'introduction

Etape 1 - Assemblage/Montage
Etape 2 - Cablage

Etape 3 - Programmation
Etape 4 - Calibration

Notes et références

Commentaires

Introduction

Vous avez recu un robot en kit de chez Freenove.

Pour I'assembler, vous devez vous aider du kit d'installation sur le site internet de Freenove. Le lien et le type de robot sont marqués sur la
boite du robot.

Dans ce tutoriel, nous allons nous concentrer sur le robot hexapode, dont le comportement est proche de celui d'une araignée (pour rappel
une araignée posséde 8 pattes).

Matériaux Outils

(@' https://www.youtube.com/watch?v=nivTZeGthf4&ab_channel=Freenove

Etape 1 - Assemblage/Montage

Une carte microcontrdleur sur laquelle on va connecter les 12 servo-moteurs (2 par patte), et un petit module WIFI ESP 8266 composent
I'essentiel de ce robot.
Vous trouverez dans la partie Fichiers (a coté de Outils et Matériaux) un lien vidéo pour I'assemblage.
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The correct location is as below.

Assemble 5 other acrylic plates.
Note the direction of acrylic plates. Three of them are opposite to the other three.
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Use screws and nuts to fix two parts assembled before.

-

-
| M3#12
Screw [

{ M3 l\hl.ul ‘
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Use screws to fix the 6 parts assembled before.
Please note the installation angle of 6 parts. (Refer to the installation result at the end of this step.)
! When installing, you must keep the power on and all servos connected.

‘\
This screw is packed ‘ T ]
with servo and it is the 2
smaller of the 5 screws.

Fix them as below.

Etape 2 - Cablage

2 batteries de 3.7V seront nécessaires pour le faire marcher.

3.7V 14500 rechargeable battery x2
! Please prepare the right batteries and fully charge them before assembling.
(Refer to “AboutBattery.pdf” for detailed information about battery.)

! Assembling without right batteries will cause installation errors, which may damage the servos.

Charger for 3.7V 14500 rechargeable battery x1
(Any charger that can charge 3.7V 14500 rechargeable battery.)
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Connect the control board to your computer with a USB cable.

Select the port.

X Your port may be different from that in the following figure.

®  On Windows: It may be COM4, COMS (Arduino Mega or Mega 2560) or something like that.

®  On Mac: It may be /dev/cu.usbserial-710, /dev/cu.usemodem7101 (Arduino Mega or Mega 2560) or
something like that.

®  On Linux: It may be /dew/ttyUSBO, /dev/ttyACMO or something like that.

File Edit Sketch Tools Help

Auto Format Cirl+T
Archive Sketch

Fix Encoding & Reload

Manage Libraries...

Blink

Ctrl+Shift+1
Ctrl+Shift+M
Ctrl+Shift+L

Serial Monitor
Serial Plotter

WiFi101 / WiFININA Firmware Updater

Board: "Arduino Mega or Mega 2560" >
Processor: "ATmega2560 (Mega 2560)" »
Port: "COMS3 (Arduino Mega or Mega 2560)" |
Get Board Info

ngrammer‘ "AVRISP mikll* >

Burn Bootloader

Serial ports

[V COM3 (Arduino Mega or Mega zssa}l}

[sI€H If there are more than one ports and you cannot decide which one to choose, disconnect the USB

cable and check the port. Then connect the USB cable and check the port again. The newly appeared one is

the correct port.

R RICENEY Contact us for help! Send mail to: support@freenove .com
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Wait a moment for the uploading to be completed

Click "Verify" button.

& Blink | Arduino 1.

e Edit Sketch Tools Help

Verify

EVLETECLIEE Contact us for help! Send mail to: support@freenove.com

Figure below shows the code is being compiled.

After that, we will see the LED marked with "L" on the control board starts blinking. It indicates that the code
is running now!

LED L starts
blinking

Wait a moment for the compiling to be completed. Figure below shows the code size and percentage of
space occupation. If there is any error in the code, the compilation will fail and the details will be shown here.

Arduine Mega or M

Click "Upload" button.
& Blink | Arduino [m] X

e Edit Sketch Tools Help

So far, we have completed the first use. | believe you have felt the joy of it
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Now we will make a test and then set the control board to installation mode.

Take out all the servos and connect all of them to the control board (yellow wire of servo to §, red to +,
black to -). Servas can be connected randomly to the port 22-39
(The name of the port is marked on the front of the control board.)

o

Then install your batteries and keep power off,

Connect the control board to computer via USB cable. Then open Processing App and click "CONNECT"
After the connection succeeds, turn on the power, The servos will ratate and then stop, The battery vaoltage
will be displayed on the Processing App.
© Processinghpp

CONTROL v 3 CALIBRATION | INSTALLATION

DISCONN Ready

| The battery voltage should be around 8.0~8.4V,
If the voltage is less than 8V, please charge the batteries and then try again, If you still get the same result,
maybe you have wrong batteries. Please check the type of your battery or check whether there is a protective
board. Refer to "AboutBattery pdf” for detailed information about battery.

If there is no problem with the voltage, then we need to set the control board to installation made.

Click "INSTALLATION" on the top. Wait for processing and the servos will rotate again

© Processinghpp X
TWIST BO ALIBRATION SINSTS L_ATION.

Processing...
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Click "DISCONNECT" to disconnect. The control board will restart and the servos will rotate again
© ProcessingApp
CONTROL TWIST BODY CALIBRATION FINSTALLATION

DISCONNECT, Ready

! The LED "L" on the control board now should flash three times at intervals.
It is indicating that the control board is under installation mode.
If the LED L does not flash like this, you need to use Processing App to set the control baord again.
You have to do this step correctly, Otherwise, it will cause installation errors and damage the servos
If you meet problems, check your batteries or ask our support team for help

I Switch the power off, disconnect the USB cable, remove the batteries and disconnect all the servos,
Now let us learn about the signal LED (LED “L" on the control board), which can indicate current state of the
rabot. You should always observe it, which is very important and useful. See "SignalLED.mp4” in "Videos”
folder

The signal LED will flash several times every few seconds (circularly)

In each cycle, if the LED lights up several times and then stays OFF, it indicates different working mode:

Blinks once: ready mode,
This mode should be set after completing installation and calibration of the robot

Blinks twice: calibration mode.

This mode should be set when calibrating the robot
X Blinks 3 times: installation mode.

This mode should be set when installing the robot

=5

o

The working mode of the robot can be set through Processing App. The robot will remember the working
mode you set, even if you restart the power, the robot will still enter the mode you set originally.

In each cycle, if the LED goes off several times and then stays ON, it indicates an error state:
(Only applicable to V2.0 and later versions control board)

ges Blinks once: power error.

° It indicates that the voltage of battery is too low and that it needs to be charged.

The robot will stop all movements and cut off power of all servos when there is an error, You must
troubleshoot the error before you can continue to use it

Etape 3 - Programmation

Ce robot est compatible avec I'environnement de programmation Arduino et Processing sur les 3 plateformes d'exploitation (Windows, Mac

Os et Linux).
Il faudray télécharger quelques librairies : FNHR, FlexiTimer2, RF24 sur Arduino et IP5 sur Processing.
Et I'application ProcessingApp suffira a contréler le robot.
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Select the Mac, Windows, or Linux version, depending on what machine you have.

o x
L S £+ @0 | @ Downioad \ Processing.. 2 o . r . ™ b 2
o 2 - 1 Please do not skip this chapter if you have never installed Processing IDE or are not familiar with it,
~
/ Processing The Processing IDE is free and open source. It is used to write graphical programs run on computers. Mast
code written with it can run directly on Windows, macOS and Linux without any changes
Download Processing. Processing is available for Linux, Mac 0S X, and i N X X
i Windows. Select your choice to download the software below. We provide a Processing sketch to configure and control the robot.
ar
Windows Linux MacOS X
Processing IDE
Linux
Processing IDE uses Java programming language by default
Read about the chasiges n 1.0, Thelis oftevisions coversthe differences
s s e Please visit wa.org/, click "Reference” for details.
1 Do not worry if you do not know Java, because we provide complete code.
v
Installation on each machine is straightforward: First, install Processing IDE. Visit https://processing.org/, click "Download” to enter the download page.
+  On Windows, you'll have a zip file. Double-click it, and drag the folder inside to a location on your 9 o = S0 §tvunbosy

hard disk. It could be Pragram Files or simply the desktop, but the important thing is for the
processing folder to be pulled out of that .zip file. Then double-click processing.exe to start.

* The Mac OS X version is also a .zip file. Double-click it and drag the Processing icon to the
Applications folder. If you're using someone else's machine and can't modify the Applications folder,
just drag the application to the desktop. Then double-click the Processing icon to start. %

* The Linux version is a tar.gz file, which should be familiar to mast Linux users. Download the file to v

Donate

your home directory, then open a terminal window, and type:
tar xvfz processing - xoxx.tgz

(Replace xxxx with the rest of the file's name, which is the version number.) This will create a folder Exhibition
named processing-2.0 or something similar. Then change to that directory:
cd processing -xxxx ?J.
and run it: 5

+ Downlo —_—
/processing Browse Tutorials ¥ Lot Mostebeom

Visit the Reference

s
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In the editor, type the following:

[T eliipse(so, 50, 80, 80); |

This line of code means "draw an ellipse, with the center 50 pixels over from the left and 50 pixels down from
the top, with a width and height of 80 pixels.” Click the Run button (the triangle button in the Toolbar).

@ sketch_170327a | Processing 3.3 - [m] X
File Edit Sketch Debug Tools Help

sketch_170327a
I =1lipse(se, 50, 80, 80); ~

If you've typed everything correctly, you'll see a circle on your screen,

o x

If you didn't type it correctly, the Message Area will turn red and complain about an error. If this happens,
make sure that you've copied the example code exactly: the numbers should be contained within parentheses
and have commas between each of them, and the line should end with a semicolon.

Missing a serr

Click "Verify" button.

& Blink | Arduino

Figure below shows the code is being compiled.

Mega or Mega 2t

Wait a moment for the compiling to be completed. Figure below shows the code size and percentage of
space occupation. If there is any error in the code, the compilation will fail and the details will be shown here.

Assembly

Now let us start assembling the robot

! Please prepare the right batteries and fully charge them before assembling. (See “AboutBattery.pdf")
Assembling without right batteries will cause installation errors, which may damage the servos

! Please read and complete the previous chapters “Arduino IDE" and “Processing IDE" first,
In the previous chapters we showed you how to install the required software.

! Please follow the tutorial strictly and do not skip any steps.
Ask our suppart for help if you encounter a problem instead of ignoring it

! Do not open files in the original ZIP file directly.
After you download the ZIP file for this product, unzip it before use.

First, we need to upload the default sketch to the control board (Freenove Crawling Robot Controller).
Libraries are collections of code that makes programming simple.
The "FNHR" (Freenove Hexapod Robot) library is used to control this robot. We need to add it and other

necessary libraries to Arduino IDE

Open Arduino IDE, click “Sketch” > “Include Library” > “Add .ZIP Library.."” to add a library file.

@ gketch_aug05a | Arduino 1.8.13

File Edit Sketch Tools Help

Verify/Compile Ctrl+R
Upload Ctrl4+U

skatch | Upload Using Programmer Ctrl+Shift+U

Export compiled Binary Ctrl+Alt+S Manage Libraries..  Ctrl+Shift+]
Py
Show Sketch Folder Ctrl+K Add .ZIP Library... %
} Include Library |

Arduino libraries

Add File... Bridge

Add all library files in "ArduinoLibraries” folder. This folder is in the folder that contains this PDF tutorial.

You can find the added libraries in “Sketch” > “Include Library”. Make sure all the following libraries have been
added.

@ sketch_jan15a | Arduino 1.8.13 WiH
File Edit Sketch Tools Help e
Verify/Compile Ctrl+R Contributed libraries
Upload cirl+U ( FNHR |
skatch| Upload Using Programmer Ctrl+Shift+U[ FlexiTimer2 ]
roid se Export compiled Binary Ctrl+Alt+S [ RF24 ]
pu |
[ Show Sketch Folder Crl+K Recommended libraries
} Include Library 3 Adafruit Circuit Playground
Add File...

Now open "File" > "Examples” > "FNHR" > "Default” > "Robot".

5a | Arduino EEPROM -
File Edit Sketch Tools Help SoftwareSerial .
New Curl+N 5 i
Oper Cils0 Wire 2
Open Recent 1 Examphes from Custom Lib
Sketchbook 3 FlexiTimer2 »
Examples I ORNHR 5 Defaul | Remote
Close Ctrl+W RF24 H Examples 3 Robot
Save Curl+s WeeESPE266 ModifyAction > &
Save As... Ctrl+5hift+5 ModifyRemote >
Poge Eotvp Cobistit | o L itz S
Print P e ?
ModifyWiFi >
Preferences Ctrl+Comma ModifyWiFiChannel >
Quit cul+Q Joet 2
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Etape 4 - Calibration

normalement avec dans le kit du robot se trouve une feuille de calibration blanche. normalement une fois monté placé simplement le robot

sur la feuille.

Avertissement: en mettent le robot sur la feuille, les pattes doivent étre parfaitement placé sur les point car si jamais se n'ai pas le cas, a

chaque fois que vous |'allumer les pates ne seront pas droite
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Step 17

At the end of the assembly, let us calibrate the servos.
Keep the power off.

Then connect the robot with Processing App. After the connection succeeds, click "CALIBRATION" on the top.

CALIBRATION" INSTALLATION

Ready

LEG1 LEG2 LEG3 LEC4 LEGS LEG6

Press Enter to visit Freenove.com

Then start calibrate. Select "LEG1", and then click "X+", "X-", "Y+", "Y-" and "Z+", "Z-", until the end of Legl
is aligned with the black dots in the graph.

! Please note that each click will only move the leg by 1mm, so you may need to click many times.
You can use keyboard to move the leg. The key is marked in brackets on the button,

Then select the "LEG2", "LEG3", "LEG4", "LEG5"and "LEG6" to move other legs to corresponding dots as shown
below.

Click "CONFIRM" and the calibration data will be stored in the robot.

Click "VERIFY", and then the robot will restore to the state before calibration, Then converted to the state after
calibration, which indicates that the calibration is completed. If the end of legs is not aligned with the dots,
click RESET and restart from moving the legs to try again.

The calibration needs to be executed only once. Its data is stored in EEPROM. It will not be changed if you
upload the default sketch again. If you disassemble the robot, replace the servo or control board, you need
to calibrate the robot again. If you are not satisfied with the results of the latest calibration, you can also
choose to calibrate again.
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!'If the Processing App cannot connect to the robot, please try the following:
1. Checkif the ESP8266 module is installed correctly.
2. Fully charge the 14500 battery.
3. Go back to step 01 and upload the default sketch for the robot again.
4. Try different Wi-Fi channels.

EVLC NG ERIEY Contact us for help! Send mail to: support@freenave.com

In the "CONTROL" page, you can control the basic functions of the robot

@ ProcessingApp - x

CONTROL TWIST BODY / \TION | INSTALLATION

RIGHT(D,

BACKWAR

ACTIVAT ) DEACT

Enter to visit Freenove.com
You can execute the following operation:
® Forward, backward, left, right, turn left, turn right and change body's height.
®  Switch active mode and sleep mode. Sleep mode can help to save the power of batteries.
® Switch output state of 10 ports. You can connect and control some output modules.

You can use keyboard to move the leg. The key is marked in brackets on the button.
In the "TWIST BODY" page, you can control the rabot to move and rotate body in the place where it stays.

© ProcessingiApp X
TWIST BODY CALIBRATION | INSTAL

Ready

ROTATE 0,0 ZROTATE

Press Enter to visit Freenove.com

You can execute the following operation:

® Use mouse to click on the "MOVE" box and "ZMOVE" slider, the robot body will move to the
corresponding location,

® Use mouse to click on the "ROTATE" box and "ZROTATE" slider, the robot body will rotate to the
corresponding posture,

If there is no action command for about 10 seconds, the robot will switch into sleep mode automatically to
save power. Any command can activate the robot again.

Use A d Devices o e

You can use Android phone or tablet or iPhone to control this robot.

First, install Freenove App for your device:
®  For Android, search and install "Freenove” on Google Play. You can also download the APK file directly:
https//qithub.com/Freenove/Freenave_App_for_Android/raw/master/freenove. apk

®  ForiPhone, search and install “Freenove” on App store.

After the installation is completed, connect your device to the Wi-Fi hotspot of the robot.
The name of Wi-Fi hotspot is "Freenove Hexapod Robot” and the password is "Freenove” (case sensitive).
Open Freenove App and select “Freenove Hexapod Robot Kit". The following interface will be displayed.

B
® O

The App will connect the robot automatically. The online state will appear on the top. If the offline state
appears, you can touch the robot logo on the tap left comer to reconnect.

This APP is similar to the Processing App. You can explore it by yourself. There is also a manual about it:
ht

//github com/Freengve/Freenove App for Android/re

v/master/Tutorial. pdf

Contact us for help! Send mail to: support@freenove com
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Notes et références

Si vous avez des difficultés avec le montage des robots ou qu'il vous manque des piéces, vous pouvez aller sur le site https://freenove.com/
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